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この章では、ASAソフトウェアおよびコンフィギュレーションの管理方法について説明しま
す。

•ソフトウェアのアップグレード（1ページ）
• ROMMONを使用したイメージのロード（ISA 3000）（1ページ）
• ROMMONイメージのアップグレード（ISA 3000）（3ページ）
•ソフトウェアのダウングレード（5ページ）
•ファイルの管理（11ページ）
• ASAイメージ、ASDM、およびスタートアップコンフィギュレーションの設定（19ペー
ジ）

•コンフィギュレーションまたはその他のファイルのバックアップと復元（22ページ）
•システム再起動のスケジュール（29ページ）
• Cisco Secure Firewall 3100/4200での SSDのホットスワップ（30ページ）
•ソフトウェアとコンフィギュレーションの履歴（33ページ）

ソフトウェアのアップグレード
完全なアップグレードの手順については、『Cisco ASAUpgrade Guide』を参照してください。

ROMMONを使用したイメージのロード（ISA 3000）
TFTPを使用して ROMMONモードから ASAへソフトウェアイメージをロードするには、次
の手順を実行します。

手順

ステップ 1 ISA 3000コンソールへのアクセスに従って、ASAのコンソールポートに接続します。
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ステップ 2 ASAの電源を切ってから、再び電源をオンにします。

ステップ 3 スタートアップの間に、ROMMONモードに入るようにプロンプト表示されたら、Escapeキー
を押します。

ステップ 4 ROMMONモードで、IPアドレス、TFTPサーバアドレス、ゲートウェイアドレス、ソフト
ウェアイメージファイル、およびポートを含む、ASAに対するインターフェイス設定を次の
ように定義します。

rommon #1> interface gigabitethernet0/0
rommon #2> address 10.86.118.4
rommon #3> server 10.86.118.21
rommon #4> gateway 10.86.118.21
rommon #5> file asa961-smp-k8.bin

ネットワークへの接続がすでに存在することを確認してください。

インターフェイスコマンドはASA5506-X、ASA5508-X、ASA5516-X、および ISA
3000プラットフォームで無視されるため、これらのプラットフォームでManagement
1/1インターフェイスから TFTPリカバリを実行する必要があります。

（注）

ステップ 5 設定を検証します。

rommon #6> set
ROMMON Variable Settings:
ADDRESS=10.86.118.3
SERVER=10.86.118.21
GATEWAY=10.86.118.21
PORT=GigabitEthernet0/0
VLAN=untagged
IMAGE=asa961-smp-k8.bin
CONFIG=
LINKTIMEOUT=20
PKTTIMEOUT=4
RETRY=20

ステップ 6 TFTPサーバーに pingを送信します。

rommon #7> ping server
Sending 20, 100-byte ICMP Echoes to server 10.86.118.21, timeout is 4 seconds:

Success rate is 100 percent (20/20)

ステップ 7 ネットワーク設定を、後で使用できるように保管しておきます。

rommon #8> sync
Updating NVRAM Parameters...

ステップ 8 システムソフトウェアイメージをロードします。

rommon #9> tftpdnld
ROMMON Variable Settings:
ADDRESS=10.86.118.3
SERVER=10.86.118.21
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GATEWAY=10.86.118.21
PORT=GigabitEthernet0/0
VLAN=untagged
IMAGE=asa961-smp-k8.bin
CONFIG=
LINKTIMEOUT=20
PKTTIMEOUT=4
RETRY=20

tftp asa961-smp-k8.bin@10.86.118.21 via 10.86.118.21

Received 14450688 bytes

Launching TFTP Image...
Cisco ASA Security Appliance admin loader (3.0) #0: Mon Mar 5 16:00:07 MST 2016

Loading...

ソフトウェアイメージが正常にロードされると、ASAは自動的に ROMMONモードを終了し
ます。

ステップ 9 ROMMONモードから ASAを起動する場合、システムイメージはリロード間で保持されない
ため、やはりイメージをフラッシュメモリにダウンロードする必要があります。完全なアップ

グレードの手順については、『Cisco ASA Upgrade Guide』を参照してください。

ROMMONイメージのアップグレード（ISA 3000）
ISA 3000の ROMMONイメージをアップグレードするには、次の手順に従います。 ASAモデ
ルの場合、システムのROMMONバージョンは1.1.8以上である必要があります。最新バージョ
ンへのアップグレードを推奨します。

新バージョンへのアップグレードのみ可能です。ダウングレードはできません。

ISA 3000の ROMMON 1.0.5へのアップグレードには、以前の ROMMONバージョンの 2倍の
時間がかかります（約 15分）。アップグレード中はデバイスの電源を再投入しないでくださ
い。アップグレードが 30分以内に完了しないか、または失敗した場合は、シスコテクニカル
サポートに連絡してください。デバイスの電源を再投入したり、リセットしたりしないでくだ

さい。

注意

始める前に

Cisco.comから新しいROMMONイメージを取得して、サーバー上に置いてASAにコピーしま
す。ASAは、FTPサーバー、TFTPサーバー、SCPサーバー、HTTP（S）サーバー、および
SMBサーバーをサポートしています。次の URLからイメージをダウンロードします。

• ISA 3000： https://software.cisco.com/download/home/286288493/type
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手順

ステップ 1 ROMMONイメージを ASAフラッシュメモリにコピーします。この手順では、FTPコピーを
表示します。他のサーバータイプのシンタックスの場合は copy ?と入力します。

copy ftp://[username:password@]server_ip/asa5500-firmware-xxxx.SPA
disk0:asa5500-firmware-xxxx.SPA

ステップ 2 現在のバージョンを確認するには、showmoduleコマンドを入力して、MACアドレス範囲テー
ブルのMod 1の出力で Fwバージョンを調べます。

ciscoasa# show module
[...]
Mod MAC Address Range Hw Version Fw Version Sw Version
---- --------------------------------- ------------ ------------ ---------------

1 7426.aceb.ccea to 7426.aceb.ccf2 0.3 1.1.5 9.4(1)
sfr 7426.aceb.cce9 to 7426.aceb.cce9 N/A N/A

ステップ 3 ROMMONイメージをアップグレードします。

upgrade rommon disk0:asa5500-firmware-xxxx.SPA

例：

ciscoasa# upgrade rommon disk0:asa5500-firmware-1108.SPA
Verifying file integrity of disk0:/asa5500-firmware-1108.SPA

Computed Hash SHA2: d824bdeecee1308fc64427367fa559e9
eefe8f182491652ee4c05e6e751f7a4f
5cdea28540cf60acde3ab9b65ff55a9f
4e0cfb84b9e2317a856580576612f4af

Embedded Hash SHA2: d824bdeecee1308fc64427367fa559e9
eefe8f182491652ee4c05e6e751f7a4f
5cdea28540cf60acde3ab9b65ff55a9f
4e0cfb84b9e2317a856580576612f4af

Digital signature successfully validated
File Name : disk0:/asa5500-firmware-1108.SPA
Image type : Release

Signer Information
Common Name : abraxas
Organization Unit : NCS_Kenton_ASA
Organization Name : CiscoSystems

Certificate Serial Number : 553156F4
Hash Algorithm : SHA2 512
Signature Algorithm : 2048-bit RSA
Key Version : A

Verification successful.
Proceed with reload? [confirm]

ステップ 4 プロンプトが表示されたら、確認して ASAをリロードします。
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ASAがROMMONイメージをアップグレードして、その後オペレーティングシステムをリロー
ドします。

ソフトウェアのダウングレード
多くの場合、ASAソフトウェアをダウングレードし、以前のソフトウェアバージョンからバッ
クアップ設定を復元することができます。ダウングレードの方法は、ASAプラットフォームに
よって異なります。

ダウングレードに関するガイドラインおよび制限事項

ダウングレードする前に、次のガイドラインを参照してください。

•クラスタリング用の公式のゼロダウンタイムダウングレードのサポートはありません：
ただし場合によっては、ゼロダウンタイムダウングレードが機能します。ダウングレー

ドに関する次の既知の問題を参照してください。この他の問題が原因でクラスタユニット

のリロードが必要になることもあり、その場合はダウンタイムが発生します。

•クラスタリングを含む9.9(1)より前のリリースへのダウングレード：9.9(1)以降では、
バックアップの配布が改善されています。クラスタに3つ以上のユニットがある場合
は、次の手順を実行する必要があります。

1. クラスタからすべてのセカンダリユニットを削除します（クラスタはプライマリ
ユニットのみで構成されます）。

2. 1つのセカンダリユニットをダウングレードし、クラスタに再参加させます。

3. プライマリユニットでクラスタリングを無効にします。そのユニットをダウング
レードし、クラスタに再参加させます。

4. 残りのセカンダリユニットをダウングレードし、それらを一度に 1つずつクラス
タに再参加させます。

•クラスタサイトの冗長性を有効にする場合は、9.9(1)より前のリリースにダウングレー
ドします：ダウングレードする場合（または 9.9(1)より前のユニットをクラスタに追
加する場合）は、サイトの冗長性を無効にする必要があります。そうしないと、古い

バージョンを実行しているユニットにダミーの転送フローなどの副作用が発生しま

す。

•クラスタリングおよび暗号マップを使用する場合に 9.8(1)からダウングレードする：
暗号マップが設定されている場合に9.8(1)からダウングレードすると、ゼロダウンタ
イムダウングレードはサポートされません。ダウングレード前に暗号マップ設定をク

リアし、ダウングレード後に設定をもう一度適用する必要があります。

•クラスタリングユニットのヘルスチェックを 0.3～ 0.7秒に設定した状態で 9.8(1)か
らダウングレードする：（health-check holdtimeで）ホールド時間を 0.3～ 0.7秒に設
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定した後で ASAソフトウェアをダウングレードすると、新しい設定はサポートされ
ないため、設定値はデフォルトの 3秒に戻ります。

•クラスタリング（CSCuv82933）を使用している場合に 9.5(2)以降から 9.5(1)以前に
ダウングレードする：9.5(2)からダウングレードする場合、ゼロダウンタイムダウン
グレードはサポートされません。ユニットがオンラインに戻ったときに新しいクラス

タが形成されるように、すべてのユニットをほぼ同時にリロードする必要がありま

す。ユニットが順番にリロードされるのを待つと、クラスタを形成できなくなりま

す。

•クラスタリングを使用する場合に 9.2(1)以降から 9.1以前にダウングレードする：ゼ
ロダウンタイムダウングレードはサポートされません。

• 9.18以降からのダウングレードの問題：9.18では動作が変更され、access-groupコマンド
がその access-listコマンドの前にリストされます。ダウングレードすると、access-group
コマンドはまだ access-listコマンドをロードしていないため拒否されます。以前に
forward-reference enableコマンドを有効にしていた場合でも、このコマンドは現在削除さ
れているため同じ結果となります。ダウングレードする前にすべてのaccess-groupコマン
ドを手動でコピーし、ダウングレード後に再入力してください。

•プラットフォームモードでの 9.13/9.14から 9.12以前への Firepower 2100のダウングレー
ドの問題：プラットフォームモードに変換した 9.13または 9.14を新規インストールした
Firepower 2100の場合：9.12以前にダウングレードすると、FXOSで新しいインターフェ
イスの設定や、既存インターフェイスの編集ができなくなります（9.12以前ではプラット
フォームモードのみがサポートされています）。バージョンを9.13以降に戻すか、または
FXOSの erase configurationコマンドを使用して設定をクリアする必要があります。この問
題は、元々以前のリリースから 9.13または 9.14にアップグレードした場合は発生しませ
ん。新しいデバイスや再イメージ化されたデバイスなど、新規インストールのみが影響を

受けます。（CSCvr19755）

•スマートライセンスの 9.10(1)からのダウングレード：スマートエージェントの変更によ
り、ダウングレードする場合、デバイスをCisco Smart SoftwareManagerに再登録する必要
があります。新しいスマートエージェントは暗号化されたファイルを使用するので、古い

スマートエージェントが必要とする暗号化されていないファイルを使用するために再登録

する必要があります。

• PBKDF2（パスワードベースのキー派生関数 2）ハッシュをパスワードで使用する場合に
9.5以前のバージョンにダウングレードする：9.6より前のバージョンはPBKDF2ハッシュ
をサポートしていません。9.6(1)では、32文字より長い enableパスワードおよびusername
パスワードで PBKDF2ハッシュを使用します。9.7(1)では、すべての新しいパスワード
は、長さに関わらず PBKDF2ハッシュを使用します（既存のパスワードは引き続きMD5
ハッシュを使用します）。ダウングレードすると、enableパスワードがデフォルト（空
白）に戻ります。ユーザー名は正しく解析されず、usernameコマンドが削除されます。
ローカルユーザーをもう一度作成する必要があります。

• ASA仮想用のバージョン 9.5(2.200)からのダウングレード：ASA仮想はライセンス登録
状態を保持しません。license smart register idtoken id_token forceコマンドで再登録する必
要があります（ASDMの場合、[Configuration] > [Device Management] > [Licensing] > [Smart
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Licensing]ページで [Force registration]オプションを使用）。Smart Software Managerから
IDトークンを取得します。

•元のトンネルがネゴシエートした暗号スイートをサポートしないソフトウェアバージョン
をスタンバイ装置が実行している場合でも、VPNトンネルがスタンバイ装置に複製され
ます：このシナリオは、ダウングレード時に発生します。その場合、VPN接続を切断して
再接続してください。

ダウングレード後に削除される互換性のない設定

以前のバージョンにダウングレードすると、それ以降のバージョンで導入されたコマンドは設

定から削除されます。ダウングレードする前に、ターゲットバージョンに対して設定を自動的

にチェックする方法はありません。新しいコマンドが ASAの新しい機能にいつ追加されたか
をリリースごとに表示できます。

show startup-config errorsコマンドを使用してダウングレードした後、拒否されたコマンドを
表示できます。ラボデバイスでダウングレードを実行できる場合は、実稼働デバイスでダウン

グレードを実行する前にこのコマンドを使用して効果を事前に確認できます。

場合によっては、ASAはアップグレード時にコマンドを新しいフォームに自動的に移行するた
め、バージョンによっては新しいコマンドを手動で設定しなかった場合でも、設定の移行に

よってダウングレードが影響を受けることがあります。ダウングレード時に使用できる古い設

定のバックアップを保持することを推奨します。8.3へのアップグレード時には、バックアッ
プが自動的に作成されます（<old_version>_startup_cfg.sav）。他の移行ではバックアップが作
成されません。ダウングレードに影響する可能性がある自動コマンド移行の詳細については、

『ASAアップグレードガイド』の「バージョン固有のガイドラインと移行」を参照してくださ
い。

ダウングレードに関するガイドラインおよび制限事項（5ページ）の既知のダウングレード
の問題も参照してください。

たとえば、バージョン9.8(2)を実行している ASAには、次のコマンドが含まれています。

access-list acl1 extended permit sctp 192.0.2.0 255.255.255.0 198.51.100.0 255.255.255.0
username test1 password $sha512$1234$abcdefghijklmnopqrstuvwxyz privilege 15
snmp-server user snmpuser1 snmpgroup1 v3 engineID abcdefghijklmnopqrstuvwxyz encrypted
auth md5 12:ab:34 priv aes 128 12:ab:34

9.0(4)にダウングレードすると、起動時に次のエラーが表示されます。

access-list acl1 extended permit sctp 192.0.2.0 255.255.255.0 198.51.100.0 255.255.255.0

^
ERROR: % Invalid input detected at '^' marker.

username test1 password $sha512$1234$abcdefghijklmnopqrstuvwxyz pbkdf2 privilege 15
^

ERROR: % Invalid input detected at '^' marker.

snmp-server user snmpuser1 snmpgroup1 v3 engineID abcdefghijklmnopqrstuvwxyz encrypted
auth md5 12:ab:34 priv aes 128 12:ab:34
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^
ERROR: % Invalid input detected at '^' marker.

この例では、access-list extendedコマンドでの sctpのサポートがバージョン 9.5(2)で、username
コマンドでのpbkdf2のサポートがバージョン9.6(1)で、snmp-server userコマンドでの engineID
のサポートがバージョン9.5(3)で追加されました。

Firepower 1000、2100（アプライアンスモード）、Cisco Secure Firewall
3100/4200のダウングレード

ASAのバージョンを古いバージョンに設定し、バックアップ設定をスタートアップコンフィ
ギュレーションに復元してからリロードすることによって、ASAソフトウェアのバージョンを
ダウングレードすることができます。

始める前に

この手順ではアップグレードする前に ASAのバックアップ設定を行う必要があるため、古い
設定を復元することができます。古い設定を復元しない場合は、新規または変更された機能を

表す互換性のないコマンドが存在する可能性があります。新しいコマンドは、ソフトウェアの

古いバージョンをロードすると拒否されます。

手順

ステップ 1 スタンドアロン、フェールオーバー、またはクラスタリング展開のために、『ASA Upgrade
Guide』のアップグレード手順を使用して、ASAソフトウェアの古いバージョンをロードしま
す。この場合は、ASAの新しいバージョンではなく、古いバージョンを指定します。重要：ま
だ ASAをリロードしないでください。

ステップ 2 ASA CLIで、バックアップの ASA設定をスタートアップコンフィギュレーションにコピーし
ます。フェールオーバーの場合は、アクティブユニットでこの手順を実行します。この手順で

は、コマンドをスタンバイ装置に複製します。

copy old_config_url startup-config

writememoryを使用して実行コンフィギュレーションをスタートアップコンフィギュレーショ
ンに保存しないことが重要です。このコマンドは、バックアップ設定を上書きします。

例：

ciscoasa# copy disk0:/9.13.1_cfg.sav startup-config

ステップ 3 ASAをリロードします。

ASA CLI

reload

ASDM
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[Tools] > [System Reload]を選択します。

プラットフォームモードでの Firepower 2100のダウングレード
バックアップ設定をスタートアップコンフィギュレーションに復元し、ASAのバージョンを
古いバージョンに設定してからリロードすることによって、ASAソフトウェアのバージョンを
ダウングレードすることができます。

始める前に

この手順ではアップグレードする前に ASAのバックアップ設定を行う必要があるため、古い
設定を復元することができます。古い設定を復元しない場合は、新規または変更された機能を

表す互換性のないコマンドが存在する可能性があります。新しいコマンドは、ソフトウェアの

古いバージョンをロードすると拒否されます。

手順

ステップ 1 ASA CLIで、バックアップの ASA設定をスタートアップコンフィギュレーションにコピーし
ます。フェールオーバーの場合は、アクティブユニットでこの手順を実行します。この手順で

は、コマンドをスタンバイ装置に複製します。

copy old_config_url startup-config

writememoryを使用して実行コンフィギュレーションをスタートアップコンフィギュレーショ
ンに保存しないことが重要です。このコマンドは、バックアップ設定を上書きします。

例：

ciscoasa# copy disk0:/9.12.4_cfg.sav startup-config

ステップ 2 FXOSでは、スタンドアロン、フェールオーバー、あるいはクラスタリング展開のために、
Chassis Managerまたは FXOS CLIを使用し、『ASA Upgrade Guide』のアップグレード手順に
従って ASAソフトウェアの古いバージョンを使います。この場合は、ASAの新しいバージョ
ンではなく、古いバージョンを指定します。

Firepower 4100/9300のダウングレード
バックアップ設定をスタートアップコンフィギュレーションに復元し、ASAのバージョンを
古いバージョンに設定してからリロードすることによって、ASAソフトウェアのバージョンを
ダウングレードすることができます。

ソフトウェアおよびコンフィギュレーション
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始める前に

•この手順ではアップグレードする前に ASAのバックアップ設定を行う必要があるため、
古い設定を復元することができます。古い設定を復元しない場合は、新規または変更され

た機能を表す互換性のないコマンドが存在する可能性があります。新しいコマンドは、ソ

フトウェアの古いバージョンをロードすると拒否されます。

• ASAの古いバージョンが、FXOSの現在のバージョンと互換性があることを確認します。
互換性がない場合は、古い ASA設定を復元する前に最初の手順として FXOSをダウング
レードします。ダウングレードされた FXOSも、（ダウングレードする前に）ASAの現
在のバージョンと互換性があることを確認してください。互換性を実現できない場合は、

ダウングレードを実行しないことをお勧めします。

手順

ステップ 1 ASA CLIで、バックアップの ASA設定をスタートアップコンフィギュレーションにコピーし
ます。フェールオーバーまたはクラスタリングの場合は、アクティブ/制御ユニットでこの手
順を実行します。この手順では、コマンドをスタンバイ/データユニットに複製します。

copy old_config_url startup-config

writememoryを使用して実行コンフィギュレーションをスタートアップコンフィギュレーショ
ンに保存しないことが重要です。このコマンドは、バックアップ設定を上書きします。

例：

ciscoasa# copy disk0:/9.8.4_cfg.sav startup-config

ステップ 2 FXOSでは、スタンドアロン、フェールオーバー、あるいはクラスタリング展開のために、
Chassis Managerまたは FXOS CLIを使用し、『ASA Upgrade Guide』のアップグレード手順に
従って ASAソフトウェアの古いバージョンを使います。この場合は、ASAの新しいバージョ
ンではなく、古いバージョンを指定します。

ステップ 3 また、FXOSをダウングレードする場合は、スタンドアロン、フェールオーバー、あるいはク
ラスタリング展開のために、ChassisManagerまたはFXOSCLIを使用し、『ASAUpgradeGuide』
のアップグレード手順に従ってFXOSソフトウェアの古いバージョンを最新のバージョンに設
定します。

ISA 3000のダウングレード
ダウングレードでは、ISA3000モデルで以下の機能を完了するためのショートカットが存在し
ます。

•ブートイメージコンフィギュレーションのクリア（clear configure boot）。

•古いイメージへのブートイメージの設定（boot system）。

ソフトウェアおよびコンフィギュレーション
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•（オプション）新たなアクティベーションキーの入力（activation-key）。

•実行コンフィギュレーションのスタートアップへの保存（writememory）。これにより、
BOOT環境変数を古いイメージに設定します。このため、リロードすると古いイメージが
ロードされます。

•古いコンフィギュレーションのバックアップをスタートアップコンフィギュレーションに
コピーします（copy old_config_ur startup-config）。

•リロード（reload）。

始める前に

•この手順ではアップグレードする前に ASAのバックアップ設定を行う必要があるため、
古い設定を復元することができます。

手順

ステップ 1 [Tools] > [Downgrade Software]を選択します。

[Downgrade Software]ダイアログボックスが表示されます。

ステップ 2 ASAイメージの場合、[Select Image File]をクリックします。

[Browse File Locations]ダイアログボックスが表示されます。

ステップ 3 次のいずれかのオプションボタンをクリックします。

• [Remote Server]：ドロップダウンリストで [ftp]、[smb]、[http]のいずれかを選択し、以前
のイメージファイルのパスを入力します。

• [Flash File System]：[Browse Flash]をクリックして、ローカルフラッシュファイルシステ
ムにある以前のイメージファイルを選択します。

ステップ 4 [Configuration]で [Browse Flash]をクリックし、移行前の設定ファイルを選択します。

ステップ 5 （任意）バージョン 8.3よりも前のアクティベーションキーに戻す場合は、[Activation Key]
フィールドで以前のアクティベーションキーを入力します。

ステップ 6 [Downgrade]をクリックします。

ファイルの管理
ASDMには、基本的なファイル管理タスクを実行するのに便利なファイル管理ツールセット
が用意されています。ファイル管理ツールにより、フラッシュメモリに保存されているファイ

ルの表示、移動、コピー、および削除、ファイルの転送、およびリモートストレージデバイ

ス（マウントポイント）のファイルの管理を行うことができます。

ソフトウェアおよびコンフィギュレーション

11

ソフトウェアおよびコンフィギュレーション

ファイルの管理



マルチコンテキストモードの場合、このツールはシステムのセキュリティコンテキストでだ

け使用できます。

（注）

ファイルアクセスの設定

ASAでは、FTPクライアント、セキュアコピークライアント、または TFTPクライアントを
使用できます。また、ASAをセキュアコピーサーバーとして設定することもできるため、コ
ンピュータでセキュアコピークライアントを使用できます。

FTPクライアントモードの設定

ASAでは、FTPサーバーとの間で、イメージファイルやコンフィギュレーションファイルの
アップロードおよびダウンロードを実行できます。パッシブFTPでは、クライアントは制御接
続およびデータ接続の両方を開始します。パッシブモードではデータ接続の受け入れ側となる

サーバーは、今回の特定の接続においてリッスンするポート番号を応答として返します。

手順

ステップ 1 [Configuration] > [Device Management] > [Management Access] > [File Access] > [FTP Client]ペイン
で、[Specify FTP mode as passive]チェックボックスをオンにします。

ステップ 2 [Apply]をクリックします。

FTPクライアントのコンフィギュレーションが変更され、その変更内容が実行コンフィギュ
レーションに保存されます。

ASAセキュアコピークライアントの設定

ASAが SCPクライアントとして動作する場合は、copyコマンドを使用して SCPを設定できま
す。

SCPのパフォーマンスは、使用する暗号化アルゴリズムにある程度依存します。デフォルト
で、ASAは 3des-cbc aes128-cbc aes192-cbc aes256-cbc aes128-ctr aes192-ctr aes256-ctrの順にアル
ゴリズムをネゴシエートします。提示された最初のアルゴリズム（3des-cbc）が選択された場
合、aes128-cbcなどの一層効率的なアルゴリズムが選択された場合よりも大幅にパフォーマン
スが低下します。提示された暗号方式を変更するには、[設定（Configuration）]> [デバイス管
理（Device Management）] > [詳細（Advanced）] > [SSH暗号（SSH Ciphers）]ペインを使用
します。たとえば、[カスタム（Custom）]を選択して aes128-cbcに設定します。

始める前に

• SSHバージョン 2接続をサポートするには、ASAのライセンスに強力な暗号化
（3DES/AES）ライセンスが必要です。

ソフトウェアおよびコンフィギュレーション
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•特に指定されていないかぎり、マルチコンテキストモードでは、システム実行スペース
で次の手順を実行します。まだシステムコンフィギュレーションモードに入っていない

場合、[Configuration] > [Device List]ペインで、アクティブなデバイスの IPアドレスの下に
ある [System]をダブルクリックします。

• SCPサーバーの場合は、ASDM、その他のクライアントの HTTPSアクセスの設定に従っ
て ASAで SSHを有効にします。

手順

ステップ 1 コンテキストモードによって次のように異なります。

•シングルモードの場合、[Configuration] > [DeviceManagement] > [ManagementAccess] > [File
Access] > [Secure Copy (SCP)]の順に選択します。

•マルチモードの場合、[Configuration] > [Device Management] > [Device Administration] >
[Secure Copy]の順に選択します。

ステップ 2 （オプション）ASAは接続先の各 SCPサーバーの SSHホストキーを保存します。必要に応じ
て、ASAデータベースから手動でサーバとそのキーを追加または削除できます。

キーを追加するには、次の手順を実行します。

a) 新しいサーバーの [Add]をクリックするか、または信頼できる SSHホストのテーブルから
サーバーを選択し、[Edit]をクリックします。

b) 新しいサーバーの [Host]フィールドに、サーバーの IPアドレスを入力します。
c) [Add public key for the trusted SSH host]チェックボックスをオンにします。
d) 次のいずれかのキーを指定します。

•フィンガープリント：すでにハッシュされているキーを入力します。たとえば、show
コマンドの出力からコピーしたキーです。

•キー：SSHホストの公開キーまたはハッシュ値を入力します。キーストリングはリ
モートピアのBase64で符号化されたRSA公開キーです。オープン SSHクライアント
から（言い換えると .ssh/id_rsa.pubファイルから）公開キー値を取得できます。Base64
で符号化された公開キーを送信した後、SHA-256によってそのキーがハッシュされま
す。

キーを削除するには、信頼できる SSHホストのテーブルからサーバーを選択し、[Delete]をク
リックします。

ステップ 3 （オプション）新しいホストキーが検出されたときに通知を受け取るには、[Inform me when a
new host key is detected]チェックボックスをオンにします。

デフォルトで、このオプションは有効になっています。このオプションがイネーブルになって

いる場合、ASAにまだ格納されていないホストキーを許可または拒否するように求められま

ソフトウェアおよびコンフィギュレーション
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す。このオプションがディセーブルになっている場合、ASAは過去に保存されたことがないホ
ストキーを自動的に許可します。

ステップ 4 [適用（Apply）]をクリックします。

ASA TFTPクライアントのパス設定

TFTPは、単純なクライアント/サーバーファイル転送プロトコルで、RFC783およびRFC1350
Rev. 2で規定されています。TFTPサーバーとの間でファイルをコピーできるように、ASAを
TFTPクライアントとして設定できます。これにより、コンフィギュレーションファイルを
バックアップし、それらを複数の ASAにプロパゲートできます。

ここでは、TFTPサーバーへのパスを事前定義できるため、copyおよび configure netなどのコ
マンドで入力する必要がなくなります。

手順

ステップ 1 [Configuration] > [Device Management] > [Management Access] > [File Access] > [TFTP Client]
の順に選択し、[Enable]チェックボックスをオンにします。

ステップ 2 [Interface Name]ドロップダウンリストから、TFTPクライアントとして使用するインターフェ
イスを選択します。

ステップ 3 コンフィギュレーションファイルの保存先とする TFTPサーバーの IPアドレスを [IP Address]
フィールドに入力します。

ステップ 4 コンフィギュレーションファイルの保存先とする TFTPサーバーへのパスを [Path]フィールド
に入力します。

例：/tftpboot/asa/config3

ステップ 5 Applyをクリックします。

マウントポイントの追加

CIFSマウントポイントまたは FTPマウントポイントを追加できます。

CIFSマウントポイントの追加

共通インターネットファイルシステム（CIFS）マウントポイントを定義するには、次の手順
を実行します。

手順

ステップ 1 [Configuration] > [Device Management] > [Management Access] > [File Access] > [Mount-Points]
の順に選択し、[Add] > [CIFS Mount Point]の順にクリックします。

ソフトウェアおよびコンフィギュレーション
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[Add CIFS Mount Point]ダイアログボックスが表示されます。

ステップ 2 [Enable mount point]チェックボックスをオンにします。

これにより、ASA上の CIFSファイルシステムが UNIXのファイルツリーに接続されます。

ステップ 3 [Mount Point Name]フィールドに、既存の CIFSが存在する位置の名前を入力します。

ステップ 4 [Server Name]フィールドまたは [IP Address]フィールドに、マウントポイントを配置するサー
バーの名前または IPアドレスを入力します。

ステップ 5 [Share Name]フィールドに、CIFSサーバー上のフォルダの名前を入力します。

ステップ 6 [NT Domain Name]フィールドに、サーバーが常駐する NTドメインの名前を入力します。

ステップ 7 サーバーに対するファイルシステムのマウントを認可されているユーザーの名前を、[User
Name]フィールドに入力します。

ステップ 8 サーバーに対するファイルシステムのマウントを認可されているユーザーのパスワードを、

[Password]フィールドに入力します。

ステップ 9 [Confirm Password]フィールドにパスワードを再入力します。

ステップ 10 [OK]をクリックします。

[Add CIFS Mount Point]ダイアログボックスが閉じます。

ステップ 11 [Apply]をクリックします。

FTPマウントポイントの追加

FTPマウントポイントの場合、FTPサーバーには UNIXのディレクトリリストスタイルが必
要です。Microsoft FTPサーバーには、デフォルトでMS-DOSディレクトリリストスタイルが
あります。

手順

ステップ 1 [Configuration] > [Device Management] > [Management Access] > [File Access] > [Mount-Points]
の順に選択し、[Add] > [FTP Mount Point]の順にクリックします。

[Add FTP Mount Point]ダイアログボックスが表示されます。

ステップ 2 [Enable]チェックボックスを選択します。

これにより、ASA上の FTPファイルシステムが UNIXのファイルツリーに接続されます。

ステップ 3 [Mount Point Name]フィールドに、既存の FTPが存在する位置の名前を入力します。

ステップ 4 [Server Name]フィールドまたは [IP Address]フィールドに、マウントポイントを配置するサー
バーの名前または IPアドレスを入力します。

ステップ 5 [Mode]フィールドで、オプションボタン（[Active]または [Passive]）をクリックして FTPモー
ドを選択します。[Passive]モードを選択した場合、クライアントでは、FTPコントロール接続
とデータ接続がともに起動します。サーバーは、この接続をリッスンするポートの番号で応答

します。

ソフトウェアおよびコンフィギュレーション
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ステップ 6 FTPファイルサーバへのディレクトリパス名を [Path to Mount]フィールドに入力します。

ステップ 7 サーバーに対するファイルシステムのマウントを認可されているユーザーの名前を、[User
Name]フィールドに入力します。

ステップ 8 サーバーに対するファイルシステムのマウントを認可されているユーザーのパスワードを、

[Password]フィールドに入力します。

ステップ 9 [Confirm Password]フィールドにパスワードを再入力します。

ステップ 10 [OK]をクリックします。

[Add FTP Mount Point]ダイアログボックスが閉じます。

ステップ 11 [Apply]をクリックします。

ファイル管理ツールへのアクセス

ファイル管理ツールを使用するには、次の手順を実行します。

手順

ステップ 1 メイン ASDMアプリケーションウィンドウで、[Tools] > [File Management]の順に選択しま
す。

[File Management]ダイアログボックスが表示されます。

• [Folders]ペインには、ディスク上にあるフォルダが表示されます。

• [Flash Space]は、フラッシュメモリの合計容量と、使用可能なメモリ容量を示します。

• [Files]領域には、選択したフォルダのファイルについて次の情報が表示されます。

•パス

•ファイル名

•サイズ（バイト単位）

•修正時刻

•選択したファイルの種類（ブートコンフィギュレーション、ブートイメージファイ
ル、ASDMイメージファイル、SVCイメージファイル、CSDイメージファイル、ま
たは APCFイメージファイル）を示す、ステータス

ステップ 2 選択したファイルをブラウザに表示するには、[View]をクリックします。

ステップ 3 選択したファイルを切り取って別のディレクトリに貼り付けるには、[Cut]をクリックします。

ステップ 4 選択したファイルをコピーして別のディレクトリに貼り付けるには、[Copy]をクリックしま
す。

ステップ 5 コピーしたファイルを選択した場所に貼り付けるには、[Paste]をクリックします。

ソフトウェアおよびコンフィギュレーション
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ステップ 6 選択したファイルをフラッシュメモリから削除するには、[Delete]をクリックします。

ステップ 7 ファイルの名前を変更するには、[Rename]をクリックします。

ステップ 8 ファイルを保存するディレクトリを新規作成するには、[New Directory]をクリックします。

ステップ 9 [File Transfer]ダイアログボックスを開くには、[File Transfer]をクリックします。詳細について
は、「ファイルの転送（17ページ）」を参照してください。

ステップ 10 [ManagePoints]ダイアログボックスを開くには、[MountPoints]をクリックします。詳細につい
ては、マウントポイントの追加 （14ページ）を参照してください。

ファイルの転送

File Transferツールにより、ローカルにあるファイルとリモートにあるファイルを転送できま
す。PCまたはフラッシュファイルシステムのローカルファイルを ASAとの間で転送できま
す。HTTP、HTTPS、TFTP、FTP、または SMBを使用して、ASAとの間でファイルを転送で
きます。

IPS SSPソフトウェアモジュールの場合、IPSソフトウェアを disk0にダウンロードする前に、
フラッシュメモリに少なくとも50%の空きがあることを確認してください。IPSをインストー
ルするときに、IPSのファイルシステム用に内部フラッシュメモリの 50%が予約されます。

（注）

ローカル PCとフラッシュ間でのファイル転送

ローカルPCとフラッシュファイルシステムとの間でファイルを転送するには、次の手順を実
行します。

手順

ステップ 1 メイン ASDMアプリケーションウィンドウで、[Tools] > [File Management]の順に選択しま
す。

[File Management]ダイアログボックスが表示されます。

ステップ 2 [File Transfer]の横にある下矢印をクリックし、続いて [Between Local PC and Flash]をクリック
します。

[File Transfer]ダイアログボックスが表示されます。

ステップ 3 ローカル PCまたはフラッシュファイルシステムのどちらかで、アップロードまたはダウン
ロードしたいファイルを選択し、目的の場所にドラッグします。または、ローカル PCまたは
フラッシュファイルシステムのどちらかで、アップロードまたはダウンロードしたいファイ

ルを選択し、右矢印または左矢印をクリックし、目的の場所にファイルを転送します。

ソフトウェアおよびコンフィギュレーション
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ステップ 4 完了したら [Close]をクリックします。

リモートサーバーとフラッシュ間でのファイル転送

リモートサーバーとフラッシュファイルシステムとの間でファイルを転送するには、次の手

順を実行します。

手順

ステップ 1 メイン ASDMアプリケーションウィンドウで、[Tools] > [File Management]の順に選択しま
す。

[File Management]ダイアログボックスが表示されます。

ステップ 2 [File Transfer]ドロップダウンリストで下矢印をクリックし、[Between Remote Server and Flash]
をクリックします。

[File Transfer]ダイアログボックスが表示されます。

ステップ 3 リモートサーバーからファイルを転送するには、[Remote server]オプションをクリックしま
す。

ステップ 4 転送対象になるソースファイルを定義します。

a) （オプション）ASAがサーバーとの通信に使用するインターフェイスを指定します。イン
ターフェイスを指定しない場合、ASAは管理専用のルーティングテーブルをチェックし
ます。ここで一致が見つからない場合はデータのルーティングテーブルをチェックしま

す。

b) サーバーの IPアドレスを含めたファイルの場所へのパスを選択します。

ファイル転送は IPv4および IPv6のアドレスをサポートしています。（注）

c) FTPの場合はリモートサーバーのタイプを、HTTPまたは HTTPSの場合はリモートサー
バーのポート番号を入力します。有効な FTPタイプは次のとおりです。

• ap：パッシブモードの ASCIIファイル

• an：非パッシブモードの ASCIIファイル

• ip：パッシブモードのバイナリイメージファイル

• in：非パッシブモードのバイナリイメージファイル

ステップ 5 フラッシュファイルシステムからファイルを転送するには、[Flash file system]オプションを選
択します。

ステップ 6 ファイルの場所へのパスを入力するか、[Browse Flash]をクリックしてファイルの場所を指定
します。

ソフトウェアおよびコンフィギュレーション
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ステップ 7 また、CLIにより、スタートアップコンフィギュレーション、実行コンフィギュレーション、
または SMBファイルシステムからファイルをコピーすることもできます。Copyコマンドの
使用方法については、CLIコンフィギュレーションガイドを参照してください。

ステップ 8 転送するファイルの宛先を定義します。

a) フラッシュファイルシステムにファイルを転送するには、[Flash file system]オプションを
選択します。

b) ファイルの場所へのパスを入力するか、[BrowseFlash]をクリックしてファイルの場所を指
定します。

ステップ 9 リモートサーバーにファイルを転送するには、[Remote server]オプションを選択します。

a) （オプション）ASAがサーバーとの通信に使用するインターフェイスを指定します。イン
ターフェイスを指定しない場合、ASAは管理専用のルーティングテーブルをチェックし
ます。ここで一致が見つからない場合はデータのルーティングテーブルをチェックしま

す。

b) ファイルの場所へのパスを入力します。
c) FTP転送の場合はタイプを入力します。有効なタイプは次のとおりです。

• ap：パッシブモードの ASCIIファイル

• an：非パッシブモードの ASCIIファイル

• ip：パッシブモードのバイナリイメージファイル

• in：非パッシブモードのバイナリイメージファイル

ステップ 10 [Transfer]をクリックしてファイル転送を開始します。

[Enter Username and Password]ダイアログボックスが表示されます。

ステップ 11 リモートサーバーのユーザー名、パスワード、ドメイン（必要な場合）が表示されます。

ステップ 12 [OK]をクリックし、ファイル転送を続行します。

ファイル転送プロセスには数分かかる場合があります。必ず終了するまでお待ちください。

ステップ 13 ファイル転送が完了したら [Close]をクリックします。

ASAイメージ、ASDM、およびスタートアップコンフィ
ギュレーションの設定

複数の ASAまたは ASDMイメージがある場合は、ブートするイメージを指定する必要があり
ます。イメージを設定しない場合はデフォルトのブートイメージが使用され、そのイメージは

意図されたものではない可能性があります。スタートアップコンフィギュレーションでは、必

要に応じて、隠しディレクトリではなく表示されるファイルシステム内のファイルを指定でき

ます。
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次のモデルのガイドラインを参照してください。

• Firepower 4100/9300シャーシ：ASAのアップグレードは FXOSによって管理されます。
ASAオペレーティングシステム内で ASAをアップグレードすることはできないため、
ASAイメージに対してこの手順を使用しないでください。ASAと FXOSは個別にアップ
グレードでき、FXOSディレクトリリストに別々に表示されます。ASAパッケージには必
ず ASDMが含まれています。

•プラットフォームモードの Firepower 2100：ASA、ASDM、および FXOSのイメージは 1
つのパッケージに一緒にバンドルされています。パッケージの更新はFXOSによって管理
されます。ASAオペレーティングシステム内でASAをアップグレードすることはできな
いため、ASAイメージに対してこの手順を使用しないでください。ASAと FXOSは個別
にアップグレードできません。常に一緒にバンドルされています。

• Firepower 1000、2100（アプライアンスモード）、Cisco Secure Firewall 3100/4200：ASA、
ASDM、および FXOSのイメージは 1つのパッケージに一緒にバンドルされています。
パッケージの更新は、次の手順を使用して ASAによって管理されます。これらのプラッ
トフォームでは、ブートするイメージを識別するために ASAが使用されますが、基盤と
なるメカニズムはレガシー ASAとは異なります。詳細については、以下のコマンドの説
明を参照してください。

•モデルの ASDM：ASDMは ASAオペレーティングシステム内からアップグレードできる
ため、バンドルされた ASDMイメージのみを使用する必要はありません。Firepower 2100
（プラットフォームモード）および Firepower 4100/9300では、手動でアップロードする
ASDMイメージは FXOSイメージリストに表示されません。ASAから ASDMイメージを
管理する必要があります。

ASAバンドルをアップグレードすると、同じ名前（asdm.bin）で
あるため、バンドル内の ASDMイメージが ASA上の前の ASDM
バンドルイメージに置き換わります。ただし、アップロードした

別のASDMイメージ（たとえば asdm-782.bin）を手動で選択する
と、バンドルアップグレード後も引き続き同じイメージが使用さ

れます。互換性のあるASDMバージョンを実行していることを確
認するには、バンドルをアップグレードする前にASDMをアップ
グレードするか、または ASAバンドルをアップグレードする直
前に、バンドルされたASDMイメージ（asdm.bin）を使用するよ
うに ASAを再設定する必要があります。

（注）

• ASA仮想：初期導入時の ASA仮想パッケージでは、ASAイメージが読み取り専用 boot:/
パーティションに配置されます。ASA仮想をアップグレードする際は、フラッシュメモ
リ内の別のイメージを指定します。後でコンフィギュレーションをクリアすると、ASA仮
想は元の展開のイメージをロードするようになることに注意してください。初期導入時の

ASA仮想パッケージには、フラッシュメモリに配置される ASDMイメージも含まれてい
ます。ASDMイメージを個別にアップグレードできます。

次のデフォルト設定を参照してください。
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• ASAイメージ：

• Firepower 1000、2100（アプライアンスモード）、Cisco Secure Firewall 3100/4200：以
前実行していたブートイメージをブートします。

•その他の物理 ASA：内部フラッシュメモリ内で見つかった最初のアプリケーション
イメージをブートします。

• ASA仮想：最初に展開したときに作成された、読み取り専用の boot:/パーティション
にあるイメージをブートします。

• Firepower 4100/9300シャーシ：どの ASAイメージをブートするかは FXOSシステム
によって決定されます。この手順を使用して ASAイメージを設定することはできま
せん。

•プラットフォームモードの Firepower 2100：どのASA/FXOSパッケージをブートする
かは FXOSシステムによって決定されます。この手順を使用して ASAイメージを設
定することはできません。

•すべてのASA上のASDMイメージ：内部フラッシュメモリ内で見つかった（この場所に
イメージがない場合は外部フラッシュメモリ内で見つかった）最初の ASDMイメージを
ブートします。

•スタートアップコンフィギュレーション：デフォルトで、ASAは、隠しファイルである
スタートアップコンフィギュレーションからブートします。

手順

ステップ 1 [設定（Configuration）] > [デバイス管理（Device Management）] > [システムイメージ/設定
（System Image/Configuration）] > [ブートイメージ/設定（Boot Image/Configuration）]を選
択します。

Firepower 1000、2100（アプライアンスモード）、Cisco Secure Firewall 3100/4200：1つのイ
メージのみ追加できます。新しいイメージにアップグレードする場合は、以前に設定したイ

メージを削除する必要があります。この変更を適用すると、システムによってアクションが実

行されます。システムはイメージを検証して解凍し、ブート場所 (FXOSによって管理される
disk0の内部ロケーション)にコピーします。ASAをリロードすると、新しいイメージがロード
されます。リロードする前に注意してください。ブートイメージの場所を削除して再適用する

と、ブートロケーションから新しいイメージを削除できます。そのため、現在のイメージは引

き続き実行されます。この変更を適用した後、ASAのフラッシュメモリから元のイメージファ
イルを削除することもできます。また、ASAはブート場所から正しく起動します。他のモデル
とは異なり、スタートアップコンフィギュレーション内のこのコマンドは、ブートイメージに

は影響しません。リロード時には、最後にロードされたブートイメージが常に実行されます。

Ciscoダウンロードサイトからロードできるのは、元のファイル名のイメージのみです。ファ
イル名を変更した場合はロードされません。

他のモデル：起動イメージとして使用するバイナリイメージファイルは、ローカルから4つま
で指定できます。また TFTPサーバーのイメージを 1つ指定して、そこからデバイスをブート
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できます。TFTPサーバーに格納されているイメージを指定する場合は、そのファイルをリス
ト内の先頭に配置する必要があります。デバイスが、イメージのロード元の TFTPサーバに到
達できない場合は、フラッシュメモリに保存されているリスト内の次のイメージファイルの

ロードが試行されます。

ステップ 2 [ブートイメージ/設定（Boot Image/Configuration）]ペインで [追加（Add）]をクリックしま
す。

ステップ 3 ブートするイメージを参照します。TFTPイメージの場合は、[ファイル名（FileName）]フィー
ルドに TFTP URLを入力します。[OK]をクリックします。

ステップ 4 [上へ移動（Move Up）]ボタンと [下へ移動（Move Down）]ボタンを使用してイメージの順番
を並べ替えます。

ステップ 5 （オプション）[ブート設定ファイルパス（Boot Configuration File Path）]フィールドで、[フ
ラッシュを参照（BrowseFlash）]をクリックしてコンフィギュレーションを選択してスタート
アップコンフィギュレーションファイルを指定します。[OK]をクリックします。

この機能は、隠しディレクトリに収まらない大規模な設定を使用する場合に重要です。大規模

な設定を保存する場合、次のエラーメッセージが表示されるときは、代わりにこのコマンドを

使用して設定を新しいファイルに保存してください。

%Error writing. nvram:/startup-config (No space left on device:)

ステップ 6 [ASDMイメージファイルパス（ASDM Image File Path）]フィールドで、[フラッシュを参照
（Browse Flash）]をクリックしてイメージを選択して ASDMイメージを指定します。[OK]を
クリックします。

ステップ 7 [Apply]をクリックします。

コンフィギュレーションまたはその他のファイルのバッ

クアップと復元
システム障害に備えて、コンフィギュレーションファイルなどのシステムファイルを定期的

にバックアップすることを推奨します。

完全なシステムバックアップまたは復元の実行

次の手順では、コンフィギュレーションおよびイメージの zipバックアップ zipファイルへの
バックアップおよび復元方法と、そのファイルのローカルコンピュータへの転送方法について

説明します。

バックアップまた復元を開始する前に

•バックアップまたは復元を開始する前に、バックアップまたは復元場所に使用可能なディ
スク領域が少なくとも 300 MBある必要があります。
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• ASAは、シングルコンテキストモードである必要があります。

•バックアップ中またはバックアップ後にコンフィギュレーションを変更した場合、その変
更内容はバックアップに含められません。バックアップの実行後にコンフィギュレーショ

ンを変更してから復元を実行した場合、このコンフィギュレーションの変更は上書きされ

ます。結果として、ASAは異なる挙動をすることもあります。

•一度に開始できるバックアップまたは復元は 1つだけです。

•コンフィギュレーションは、元のバックアップを実行したときと同じ ASAバージョンに
のみ復元できます。復元ツールを使用して、ASAの異なるバージョン間でコンフィギュ
レーションを移行することはできません。コンフィギュレーションの移行が必要な場合、

ASAは、新しいASAOSをロードした時に常駐するスタートアップコンフィギュレーショ
ンを自動的にアップグレードします。

•クラスタリングを使用する場合、バックアップまたは復元できるのは、スタートアップコ
ンフィギュレーション、実行コンフィギュレーション、およびアイデンティティ証明書の

みです。ユニットごとに別々にバックアップを作成および復元する必要があります。

•フェールオーバーを使用する場合、バックアップの作成および復元は、アクティブユニッ
トとスタンバイユニットに対して別々に行う必要があります。

• ASAにマスターパスフレーズを設定している場合は、この手順で作成したバックアップ
コンフィギュレーションの復元時にそのマスターパスフレーズが必要となります。ASA
のマスターパスフレーズが不明な場合は、マスターパスフレーズの設定を参照して、バッ

クアップを続行する前に、マスターパスフレーズをリセットする方法を確認してくださ

い。

• PKCS12データをインポート（crypto ca trustpointコマンドを使用）する際にトラストポ
イントが RSAキーを使用している場合、インポートされたキーペアにはトラストポイン
トと同じ名前が割り当てられます。この制約のため、ASDMコンフィギュレーションを復
元した後でトラストポイントおよびそのキーペアに別の名前を指定した場合、スタート

アップコンフィギュレーションは元のコンフィギュレーションと同じになるのに、実行コ

ンフィギュレーションには異なるキーペア名が含まれることになります。つまり、キー

ペアとトラストポイントに別の名前を使用した場合は、元のコンフィギュレーションを復

元できないということです。この問題を回避するため、トラストポイントとそのキーペア

には必ず同じ名前を使用してください。

• CLIを使用してバックアップしてからASDMを使用して復元したり、その逆を行うことは
できません。

•各バックアップファイルに含まれる内容は次のとおりです。

•実行コンフィギュレーション

•スタートアップコンフィギュレーション

•すべてのセキュリティイメージ

Cisco Secure Desktopおよびホストスキャンのイメージ

Cisco Secure Desktopおよびホストスキャンの設定
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セキュアクライアント（SVC）画像とプロファイル

セキュアクライアント（SVC）のカスタマイズおよびトランスフォーム

•アイデンティティ証明書（アイデンティティ証明書に関連付けられた RSAキーペア
は含まれるが、スタンドアロンキーは除外される）

• VPN事前共有キー

• SSL VPNコンフィギュレーション

•アプリケーションプロファイルのカスタムフレームワーク（APCF）

•ブックマーク

•カスタマイゼーション

•ダイナミックアクセスポリシー（DAP）

•プラグイン

•接続プロファイル用の事前入力スクリプト

•プロキシ自動設定

•変換テーブル

• Webコンテンツ

•バージョン情報

システムのバックアップ

この手順では、完全なシステムバックアップを実行する方法について説明します。

バックアッププロセスが停止した場合は、ASDMにコンフィギュレーションをロードするため
の十分なメモリがない可能性があります。Javaコンソールで「java.lang.OutOfMemoryError」
メッセージをモニターして、メモリ不足が問題であるかどうかを確認できます。ASDMメモリ
を増やすには、ASDMコンフィギュレーションメモリの増大を参照してください。

（注）

手順

ステップ 1 コンピュータ上にフォルダを作成し、バックアップファイルを保存します。こうすると、後で

復元するときに探しやすくなります。

ステップ 2 [Tools] > [Backup Configurations]を選択します。

[Backup Configurations]ダイアログボックスが表示されます。[SSL VPN Configuration]領域の下
矢印をクリックし、SSL VPNコンフィギュレーションのバックアップオプションを確認しま
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す。デフォルトでは、すべてのコンフィギュレーションファイルがチェックされ、利用できる

場合にはバックアップされます。リスト内のすべてのファイルをバックアップするには、手順

5に進みます。

ステップ 3 バックアップするコンフィギュレーションを選択する場合は、[Backup All]チェックボックス
をオフにします。

ステップ 4 バックアップするオプションの横にあるチェックボックスをオンにします。

ステップ 5 [Browse Local to specify a directory and file name for the backup .zip file] をクリックします。

ステップ 6 [Select]ダイアログボックスで、バックアップファイルを格納するディレクトリを選択します。

ステップ 7 [Select]をクリックします。[Backup File]フィールドにパスが表示されます。

ステップ 8 ディレクトリパスの後にバックアップファイルの宛先の名前を入力します。バックアップファ

イルの名前の長さは、3～ 232文字の間である必要があります。

ステップ 9 [Backup]をクリックします。証明書をバックアップする場合や、ASAでマスターパスフレー
ズを使用している場合を除き、すぐにバックアップが続行されます。

ステップ 10 ASAでマスターパスフレーズを設定し、イネーブルにしている場合、バックアップを続行す
る前に、マスターパスフレーズが不明な場合は変更することを推奨する警告メッセージが表示

されます。マスターパスフレーズがわかっている場合は、[Yes]をクリックしてバックアップ
を続行します。ID証明書をバックアップする場合を除き、すぐにバックアップが続行されま
す。

ステップ 11 ID証明書をバックアップする場合は、証明書を PKCS12形式でエンコーディングするために
使用する別のパスフレーズを入力するように求められます。パスフレーズを入力するか、また

はこの手順をスキップすることができます。

ID証明書だけがこのプロセスによってバックアップされます。（注）

•証明書を暗号化するには、[CertificatePassphrase]ダイアログボックスで証明書のパスフレー
ズを入力および確認し、[OK]をクリックします。証明書の復元時に必要となるため、こ
のダイアログボックスに入力したパスワードを覚えておく必要があります。

• [Cancel]をクリックすると、この手順がスキップされ、証明書はバックアップされません。

[OK]または [Cancel]をクリックすると、すぐにバックアップが開始されます。

ステップ 12 バックアップが完了すると、ステータスウィンドウが閉じ、[BackupStatistics]ダイアログボッ
クスが表示され、成功または失敗のメッセージが示されます。

バックアップの「失敗」メッセージは多くの場合、指定されたタイプの既存のコン

フィギュレーションが存在しない場合に表示されます。

（注）

ステップ 13 [OK]をクリックし、[Backup Statistics]ダイアログボックスを閉じます。

バックアップの復元

zip tar.gzファイルからローカル PCに復元するコンフィギュレーションやイメージを指定しま
す。
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復元プロセスが停止した場合は、ASDMにコンフィギュレーションをロードするための十分な
メモリがない可能性があります。Javaコンソールで「java.lang.OutOfMemoryError」メッセージ
をモニターして、メモリ不足が問題であるかどうかを確認できます。ASDMメモリを増やすに
は、ASDMコンフィギュレーションメモリの増大を参照してください。

（注）

手順

ステップ 1 [Tools] > [Restore Configurations]を選択します。

ステップ 2 [Restore Configurations]ダイアログボックスで、[Browse Local Directory]をクリックし、ローカ
ルコンピュータ上の、復元するコンフィギュレーションが含まれている zipファイルを選択
し、[Select]をクリックします。[Local File]フィールドにパスと zipファイル名が表示されま
す。

復元する zipファイルは、[Tools] > [Backup Configurations]オプションを選択して作成したもの
である必要があります。

ステップ 3 [Next]をクリックします。2つ目の [RestoreConfiguration]ダイアログボックスが表示されます。
復元するコンフィギュレーションの横にあるチェックボックスをオンにします。使用可能なす

べての SSL VPNコンフィギュレーションがデフォルトで選択されています。

ステップ 4 [Restore]をクリックします。

ステップ 5 バックアップファイルの作成時に、証明書の暗号化に使用する証明書パスフレーズを指定して
いる場合は、このパスフレーズを入力するように ASDMから求められます。

ステップ 6 実行コンフィギュレーションの復元を選択した場合、実行コンフィギュレーションを結合する
か、実行コンフィギュレーションを置換するか、または復元プロセスのこの部分をスキップす

るかを尋ねられます。

•コンフィギュレーションの結合では、現在の実行コンフィギュレーションとバックアップ
された実行コンフィギュレーションが結合されます。

•実行コンフィギュレーションの置換では、バックアップされた実行コンフィギュレーショ
ンのみが使用されます。

•この手順をスキップすると、バックアップされた実行コンフィギュレーションは復元され
ません。

ASDMでは、復元操作が完了するまでステータスダイアログボックスが表示されます。

ステップ 7 実行コンフィギュレーションを置換または結合した場合は、ASDMを閉じてから再起動しま
す。実行コンフィギュレーションを復元しなかった場合は、ASDMセッションをリフレッシュ
して、変更を有効にします。
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自動バックアップおよび復元の設定（ISA 3000）
ISA 3000では、設定を保存するたびに、特定の場所への自動バックアップを設定できます。

自動復元では、完全な設定を SDフラッシュメモリカードにロードして、新しいデバイスを簡
単に設定できます。工場出荷時のデフォルト設定では、自動復元が有効になっています。

自動バックアップの設定（ISA 3000）

ISA 3000では、設定を保存するたびに、特定の場所への自動バックアップを設定できます。

始める前に

この機能は、ISA 3000のみで使用できます。

手順

ステップ 1 [構成（Configuration）] > [デバイス管理（Device Management）] > [自動バックアップと復元
の設定（Auto Backup & Restore Configuration）]の順に選択します。

ステップ 2 [自動バックアップ設定（AutomaticRestoreConfiguration）]をオンまたはオフにして、自動バッ
クアップを有効または無効にします。

自動バックアップを有効にした場合、設定を保存すると、その設定は自動的にバックアップの

場所とスタートアップコンフィギュレーションに保存されます。バックアップファイルの名前

は「auto-backup-asa.tgz」です。

次のパラメータを設定します。

• [インターフェイス（Interface）]：オフデバイスストレージを指定した場合に、バックアッ
プ URLに到達するためのインターフェイスを指定します。interface nameを指定しない場
合、ASAは管理専用のルーティングテーブルをチェックします。ここで一致が見つから
ない場合はデータのルーティングテーブルをチェックします。

• [場所（Location）]：データのバックアップに使用するストレージメディアを指定します。
URLまたはローカルストレージを指定できます。disk0は内部フラッシュドライブです。
disk1は USB 1のオプションの USBメモリスティックです。disk2は USB 2のオプション
の USBメモリスティックです。disk3は SDメモリカードです。自動復元のデフォルトは
disk3:です。

• [パスフレーズ（Passphrase）]：バックアップデータを保護するためのパスフレーズを設定
します。自動復元のデフォルトは「cisco」です。

自動復元の設定（ISA 3000）

自動復元モードは、ユーザの操作なしでデバイスのシステム設定を復元します。たとえば、保

存したバックアップ設定を含む SDメモリカードを新しいデバイスに挿入し、デバイスの電源
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をオンにします。デバイスが起動すると、システム設定を復元する必要があるかどうかを判断

するために SDカードがチェックされます。（復元は、バックアップファイルに別のデバイス
の「フィンガープリント」がある場合にのみ開始されます。バックアップファイルのフィン

ガープリントは、バックアップまたは復元操作中に現在のデバイスに一致するように更新され

ます。そのため、デバイスがすでに復元を完了している場合、またはデバイスが独自のバック

アップを作成している場合は、自動復元はスキップされます。）フィンガープリントに復元が

必要であることが示されている場合、デバイスはシステム設定を置き換えます（startup-config、
running-config、SSLVPN設定など。バックアップの内容の詳細については、システムのバック
アップ（24ページ）を参照してください）。デバイスの起動が完了すると、保存された設定
が実行されます。

工場出荷時のデフォルト設定では自動復元が有効になっているため、デバイスの事前設定を実

行しなくても、SDメモリカードにロードされた完全な設定で新しいデバイスを簡単に設定で
きます。

デバイスは、システム設定を復元する必要があるかどうかをブートプロセスの早い段階で決定

する必要があるため、ROMMON変数をチェックして、デバイスが自動復元モードかどうかを
判断し、バックアップ設定の場所を取得します。次の ROMMON変数が使用されます。

• RESTORE_MODE = {auto | manual}

デフォルトは autoです。

• RESTORE_LOCATION = {disk0: | disk1: | disk2: | disk3:}

デフォルトは disk3:です。

• RESTORE_PASSPHRASE = key

デフォルトは ciscoです。

自動復元設定を変更するには、次の手順を実行します。

始める前に

•この機能は、ISA 3000のみで使用できます。

•デフォルトの復元設定を使用する場合は、SDメモリカード（部品番号SD-IE-1GB=）を取
り付ける必要があります。

•自動復元を有効にするためにデフォルト設定を復元する必要がある場合は、configure
factory defaultコマンドを使用します。このコマンドは、トランスペアレントファイア
ウォールモードでのみ使用できます。そのため、ルーテッドファイアウォールモードの

場合は、最初に firewall transparentコマンドを使用します。

手順

ステップ 1 [構成（Configuration）] > [デバイス管理（Device Management）] > [自動バックアップと復元
の設定（Auto Backup & Restore Configuration）]の順に選択します。
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ステップ 2 [自動復元設定（Automatic Restore Configuration）]をオンまたはオフにして、自動復元を有効
または無効にします。

復元されるファイルの名前は「auto-backup-asa.tgz」です。自動復元を有効にする場合は、次の
パラメータを設定します。

• [場所（Location）]：データの復元に使用するストレージメディアを指定します。disk0は
内部フラッシュドライブです。disk1は USB 1のオプションの USBメモリスティックで
す。disk2はUSB 2のオプションのUSBメモリスティックです。disk3は SDメモリカード
です。デフォルトは disk3です。

• [パスフレーズ（Passphrase）]：バックアップデータを読み取るパスフレーズを設定しま
す。デフォルトは「cisco」です。

TFTPサーバーへの実行コンフィギュレーションの保存
この機能により、現在の実行コンフィギュレーションファイルのコピーをTFTPサーバーに保
存します。

手順

ステップ 1 [File] > [Save Running Configuration to TFTP Server]を選択します。

[Save Running Configuration to TFTP Server]ダイアログボックスが表示されます。

ステップ 2 TFTPサーバーの IPアドレスと、コンフィギュレーションファイルの保存先となる TFTPサー
バー上のファイルパスを入力して、[Save Configuration]をクリックします。

デフォルトの TFTP設定を行うには、[Configuration] > [Device Management] >
[Management Access] > [File Access] > [TFTP Client]の順に選択します。この設定を
行った後は、このダイアログボックスに、TFTPサーバーの IPアドレスと TFTP
サーバー上でのファイルパスが自動的に表示されます。

（注）

システム再起動のスケジュール
System Reloadツールにより、システムの再起動をスケジュールしたり、現在の再起動をキャ
ンセルしたりできます。

手順

ステップ 1 [Tools] > [System Reload]を選択します。
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ステップ 2 [Reload Scheduling]領域で、次の設定を定義します。

a) [Configuration State]では、再起動時に実行コンフィギュレーションを保存するか、破棄す
るかのどちらかを選択します。

b) [Reload Start Time]では、次のオプションから選択します。

•再起動をただちに実行するには、[Now]をクリックします。

•指定した時間だけ再起動を遅らせるには、[Delay by]をクリックします。再起動開始
までの時間を、時間と分単位、または分単位だけで入力します。

•指定した時刻と日付に再起動を実行するようにスケジュールするには、[Schedule at]
をクリックします。再起動の実行時刻を入力し、再起動のスケジュール日を選択しま

す。

c) [ReloadMessage]フィールドに、再起動時に開いているASDMインスタンスに送信するメッ
セージを入力します。

d) 再起動を再試行するまでの経過時間を時間と分単位で、または分単位だけで表示するに
は、[On reload failure force immediate reload after]チェックボックスをオンにします。

e) 設定に従って再起動をスケジュールするには、[Schedule Reload]をクリックします。

[Reload Status]領域には、再起動のステータスが表示されます。

ステップ 3 次のいずれかを選択します。

•スケジュールされた再起動を停止するには、[Cancel Reload]をクリックします。

•スケジュールされた再起動の終了後に [ReloadStatus]表示をリフレッシュするには、[Refresh]
をクリックします。

•スケジュールされた再起動の詳細を表示するには、[Details]をクリックします。

Cisco Secure Firewall 3100/4200でのSSDのホットスワップ
SSDが 2つある場合、起動時にRAIDが形成されます。ファイアウォールの電源が入っている
状態で CLIで次のタスクを実行できます。

• SSDの 1つをホットスワップする：SSDに障害がある場合は、交換できます。SSDが 1つ
しかない場合、ファイアウォールの電源がオンになっている間 SSDは取り外せません。

• SSDの 1つを取り外す：SSDが 2つある場合は、1つを取り外すことができます。

• 2つ目の SSDを追加する：SSDが 1つの場合は、2つ目の SSDを追加して RAIDを形成で
きます。
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この手順を使用して、SSDを RAIDから削除する前に SSDを取り外さないでください。デー
タが失われる可能性があります。

注意

手順

ステップ 1 SSDの 1つを取り外します。

a) SSDを RAIDから取り外します。

raid remove-secure local-disk {1 | 2}

remove-secureキーワードは SSDを RAIDから削除し、自己暗号化ディスク機能を無効に
して、SSDを安全に消去します。SSDを RAIDから削除するだけでデータをそのまま維持
する場合は、removeキーワードを使用できます。

例：

ciscoasa(config)# raid remove-secure local-disk 2

b) SSDがインベントリに表示されなくなるまで、RAIDステータスを監視します。

show raid

SSDが RAIDから削除されると、操作性とドライブの状態が劣化として表示されます。2
つ目のドライブは、メンバーディスクとして表示されなくなります。

例：

ciscoasa# show raid
Virtual Drive
ID: 1
Size (MB): 858306
Operability: operable
Presence: equipped
Lifecycle: available
Drive State: optimal
Type: raid
Level: raid1
Max Disks: 2
Meta Version: 1.0
Array State: active
Sync Action: idle
Sync Completed: unknown
Degraded: 0
Sync Speed: none

RAID member Disk:
Device Name: nvme0n1
Disk State: in-sync
Disk Slot: 1
Read Errors: 0
Recovery Start: none
Bad Blocks:
Unacknowledged Bad Blocks:
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Device Name: nvme1n1
Disk State: in-sync
Disk Slot: 2
Read Errors: 0
Recovery Start: none
Bad Blocks:
Unacknowledged Bad Blocks:

ciscoasa# show raid
Virtual Drive
ID: 1
Size (MB): 858306
Operability: degraded
Presence: equipped
Lifecycle: available
Drive State: degraded
Type: raid
Level: raid1
Max Disks: 2
Meta Version: 1.0
Array State: active
Sync Action: idle
Sync Completed: unknown
Degraded: 1
Sync Speed: none

RAID member Disk:
Device Name: nvme0n1
Disk State: in-sync
Disk Slot: 1
Read Errors: 0
Recovery Start: none
Bad Blocks:
Unacknowledged Bad Blocks:

c) SSDをシャーシから物理的に取り外します。

ステップ 2 SSDを追加します。

a) SSDを空のスロットに物理的に追加します。
b) SSDを RAIDに追加します。

raid add local-disk {1 | 2}

新しい SSDと RAIDの同期が完了するまでに数時間かかることがありますが、その間、
ファイアウォールは完全に動作します。再起動もでき、電源投入後に同期は続行されま

す。ステータスを表示するには、show raidコマンドを使用します。

以前に別のシステムで使用されており、まだロックされているSSDを取り付ける場合は、
次のコマンドを入力します。

raid add local-disk {1 | 2} psid

psidはSSDの背面に貼られたラベルに印刷されています。または、システムを再起動し、
SSDを再フォーマットして RAIDに追加できます。
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ソフトウェアとコンフィギュレーションの履歴

機能情報

プラット

フォームリ

リース機能名

SCPサーバとの間でファイルを転送するため、ASAは
SecureCopy（SCP）クライアントおよびサーバをサポー
トするようになりました。

次の画面が変更されました。

[Tools] > [File Management] > [File Transfer] > [Between
Remote Server and Flash] [Configuration] > [Device
Management] > [Management Access] > [File Access] >
[Secure Copy (SCP) Server]

9.1(5)/9.2(1)セキュアコピークライアントおよびサーバ

ユーザーは SSH暗号化を管理するときに暗号化モード
を選択し、さまざまなキー交換アルゴリズムに対して

HMACと暗号化を設定できます。アプリケーションに
応じて、暗号の強度を強くしたり弱くする必要がある場

合があります。セキュアなコピーのパフォーマンスは暗

号化アルゴリズムに一部依存します。デフォルトで、

ASAは 3des-cbc aes128-cbc aes192-cbc aes256-cbc aes128-ctr
aes192-ctr aes256-ctrの順にアルゴリズムをネゴシエート
します。提示された最初のアルゴリズム（3des-cbc）が
選択された場合、aes128-cbcなどの一層効率的なアルゴ
リズムが選択された場合よりも大幅にパフォーマンスが

低下します。たとえば、提示された暗号方式に変更する

には、ssh cipher encryption custom aes128-cbcを使用し
ます。

次の画面が導入されました。[Configuration] > [Device
Management] > [Advanced] > [SSH Ciphers]

9.1(7)/9.4(3)/9.5(3)/9.6(1)設定可能な SSH暗号機能と整合性アルゴリ
ズム
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機能情報

プラット

フォームリ

リース機能名

Auto Updateサーバ証明書の検証がデフォルトでイネー
ブルになりました。新しいコンフィギュレーションでは

証明書の検証を明示的にディセーブルにする必要があり

ます。証明書の確認をイネーブルにしていなかった場合

に、以前のリリースからアップグレードしようとする

と、証明書の確認はイネーブルではなく、次の警告が表

示されます。

WARNING: The certificate provided by the
auto-update servers will not be verified.
In order to verify this certificate please
use the verify-certificate option.

設定を移行する場合は、次のように確認なしを明示的に

設定します。

次の画面が変更されました。[Configuration] > [Device
Management] > [System/ImageConfiguration] > [AutoUpdate]
> [Add Auto Update Server]。

9.2(1)デフォルトでイネーブルになっている Auto
Updateサーバー証明書の検証

CLIを使用してイメージや証明書を含む完全なシステム
コンフィギュレーションをバックアップおよび復元でき

るようになりました。

変更された ASDM画面はありません。

9.3(2)CLIを使用したシステムのバックアップと復
元

新しいASA 5506W-Xイメージのリカバリおよびロード
がサポートされています。

変更された ASDM画面はありません。

9.4(1)新しいASA 5506W-Xイメージの回復および
ロード

バックアップコマンドと復元コマンドのプリセットパ

ラメータを使用して、自動バックアップ機能や自動復元

機能を有効にできます。これらの機能は、外部メディア

からの初期設定、デバイス交換、作動可能状態へのロー

ルバックなどで使用されます。

次の画面が導入されました。[Configuration] > [Device
Management] > [Auto Backup & Restore Configuration]

9.7(1)ISA 3000の自動バックアップと復元

CiscoSSHスタックを使用する場合、ASA copyコマンド
を使用して SCPサーバとの間でファイルをコピーする
には、SCPサーバサブネット/ホストの SSHアクセスを
ASAで有効にする必要があります。

9.17(1)SCPクライアントを使用する場合、CiscoSSH
スタックには SSHアクセスが必要です
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機能情報

プラット

フォームリ

リース機能名

SSDは自己暗号化ドライブ（SED）です。SSDが2つあ
る場合、ソフトウェア RAIDを形成します。

新規/変更されたコマンド： raid, show raid, show ssd

9.17(1)Cisco Secure Firewall 3100での SSDの RAID
サポート
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翻訳について
このドキュメントは、米国シスコ発行ドキュメントの参考和訳です。リンク情報につきましては
、日本語版掲載時点で、英語版にアップデートがあり、リンク先のページが移動/変更されている
場合がありますことをご了承ください。あくまでも参考和訳となりますので、正式な内容につい
ては米国サイトのドキュメントを参照ください。


